
Chapter 6: Importing Reference Data into 
EndNote

Online searching, described in the previous section, is the easiest 
way to retrieve references from online databases, but not all 
information providers offer that option.

If you have access to an online bibliographic database or 
university catalog, you can probably use EndNote’s import 
filters to import text files saved or downloaded from these 
sources. EndNote filters are configurable, so they give you the 
flexibility to import the reference data you need and eliminate 
data you do not need. 

In this part of the guided tour you will learn about:

Downloading data in a tagged output format.
Selecting an import filter and importing data into EndNote.

Open the 
Sample 
Library

If EndNote is not already running, start it and open the sample 
library (Sample_Library.enl), as shown under “Start EndNote” on 
page 25.

Search the 
Database and 
Save the 
References

Often when you search a database, the matching references are 
displayed as text, with no clear indicator between each piece of 
bibliographic information. The PubMed reference below, saved 
in a Citation format, is an example. There is no clear indicator for 
EndNote to be able to differentiate a title from an address or an 
abstract.

Am J Med Genet A. 2005 Mar 9; [Epub ahead of 
print]  

Reconstructing the behaviors of extinct 
species: An excursion into comparative 
paleoneurology.

Rogers SW.

    Salt Lake City VA-Geriatrics Research, 
Education and Clinical Center and Department 
of Neurobiology and Anatomy, University of 
Utah School of Medicine, Salt Lake City, Utah.

    How can the behavior of an extinct species 
be reconstructed-say a dinosaur such as 
Allosaurus? Despite the relatively abundant 
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fossilized remains of this and other 
dinosaurs, the incompleteness of the fossil 
record has permitted room for considerable 
speculation, mythology, and perhaps a bit of 
unsettling reflection on what factors 
contributed to the eventual fate of these 
remarkably successful animals. (continued) 
(c) 2005 Wiley-Liss, Inc.

PMID: 15759265 [PubMed - as supplied by 
publisher]

To use this information effectively, each piece of bibliographic 
information must be consistently tagged so it can be directed to 
the correct EndNote field.

Database providers typically offer several different download 
formats. Regardless of which system you are searching, you need 
to save the references in a tagged format to a text file.

For this tour, we will use a text file of PubMed references that 
were previously downloaded in the tagged MEDLINE format. 
The file Pubmed-dinosaur.txt is provided in the EndNote 
Examples folder. A single reference in the file appears like this:

PMID - 15759265
OWN - NLM
STAT - Publisher
DA - 20050310
PUBM - Print-Electronic
IS - 1552-4825
DP - 2005 Mar 9
TI - Reconstructing the behaviors of extinct 

species: An excursion into comparative 
paleoneurology.

AB - How can the behavior of an extinct species 
be reconstructed-say a dinosaur such as 
Allosaurus? Despite the relatively 
abundant fossilized remains of this and 
other dinosaurs, the incompleteness of 
the fossil record has permitted room for 
considerable speculation, mythology, and 
perhaps a bit of unsettling reflection on 
what factors contributed to the eventual 
fate of these remarkably successful 
animals. (continued) (c) 2005 Wiley-Liss, 
Inc.
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AD - Salt Lake City VA-Geriatrics Research, 
Education and Clinical Center and 
Department of Neurobiology and Anatomy, 
University of Utah School of Medicine, 
Salt Lake City, Utah.

AU - Rogers SW
LA - ENG
PT - JOURNAL ARTICLE
DEP - 20050309
TA - Am J Med Genet A
JID - 101235741
EDAT - 2005/03/11 09:00
MHDA - 2005/03/11 09:00
AID - 10.1002/ajmg.a.30538 [doi]
PST - aheadofprint
SO - Am J Med Genet A 2005 Mar 9;.

Each tag can be mapped to a corresponding EndNote field. If 
data is inconsistently tagged, or poorly delimited, it may not be 
possible to import all the data accurately. 

Choose the 
Correct Import 
Filter and 
Import into 
EndNote

Once you have captured and saved your data file in a tagged 
format, you need to identify the proper EndNote filter to import 
the data. There are hundreds of filters included with EndNote; 
each one is designed to read a specific tagged format from a 
specific information provider.

To import the sample PubMed text file into the sample library:

1. View the Library window in EndNote.

2. From the File menu, choose Import. 

3. Click the Choose File button to display a file dialog.

4. Browse to the EndNote X2\Examples folder and then 
highlight and Open the Pubmed-dinosaur.txt file.
Chapter 6: Importing Reference Data into EndNote 59



5. From the Import Option list, select Other Filters to display the 
list of filters supplied in the EndNote Filters folder. (You 
may experience a delay before EndNote displays the full list 
of filters.)

You may want to peruse the list, to get an idea of what filters 
are supplied. You can create new filters or copy and edit 
existing filters.

6. Begin typing “PubMed” to jump to that filter in the list.

If the More Info button is available, click it and notice that the 
Comments section at the bottom of the window gives tips for 
downloading references from the selected source.

7. With the PubMed (NLM) filter highlighted, click Choose.

8. Leave the other two options at their default settings:

Duplicates: Import All

By default, a reference is considered a duplicate if the 
Author, Year, Title, and Reference Type match a reference 
already in the library. You can change the duplicates criteria 
under EndNote Preferences. We will import all references 
regardless of duplicates.
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Text Translation: No Translation

This option allows you to specify the text character encoding 
of the file you import. This is important when you import 
references in languages that include extended characters. 
You would typically contact your database provider for the 
appropriate setting.

9. Click Import to import the file.

When the process is complete, only newly imported 
references display in the reference list. This is a good time to 
peruse the new references to make sure they imported as 
expected. You can display the Preview tab to view the 
formatted references, you can open individual references to 
make sure all information transferred to the correct fields, 
and you can easily edit or delete the new references.

Notice that the focus in the Groups pane has switched from 
the All References group to a new Imported References 
group. 

The Imported References group is a temporary group. It is 
replaced each time you import a new set of references, and it 
is removed when you close the library. The references 
themselves remain in the library unless you specifically 
delete them.

10. To return all of your references to the library display 
(including the newly imported references), choose Show All 
References from the References menu or click on the All 
References group.
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Summary of 
Output 
Formats and 
Corresponding 
Import 
Options

A subset of supported information providers are listed here with 
their recommended output formats. Check this list for guidance 
in order to download in the appropriate tagged format and select 
the appropriate import filter. This information was accurate at 
the time of publication, but you may need to contact your 
information provider if changes occur. You can also check our 
website at http://www.endnote.com for updated information 
and import filters.

NOTE: Some of the services listed in this table, such as EBSCO and 
WilsonWeb, have an alternate, easier way of transferring references 
into an EndNote library. See “Direct Export from Web Pages” on page 
67.

Copyright Issues and Fair Use of Downloaded Data

EndNote gives you the capability to import references downloaded from 
online databases into its libraries. Some producers of online reference 
databases expressly prohibit such use and storage of their data; others 
charge an extra fee for a license to use the data in this way. Before you 
download references from a database, be sure to carefully check the 
copyright and fair use notices for the database. Note that different 
databases may have varying restrictions, even from the same information 
provider (such as DIALOG or Ovid). 
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Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option

AARP AgeLine
(http://
research.aarp.org/
ageline/home.html)

There is no method for downloading data from this 
database. Instead, save the results screen as a plain text 
file with your web browser’s Save command. The 
resulting text file contains tags which are preceded by 18 
spaces.

Ageline (AARP) filter

ACM Digital Library
(Association for 
Computing Machinery)

Users with subscription access to this website can save 
multiple records to a BINDER. Once saved, you can 
export the records in an EndNote format.

Non-subscribers can download one record at a time: 

1. Create a search.

2. Click on an article.

3. Scroll half-way down the page and select DISPLAY 
EndNote.

Limitations:

Since only plain text files can be imported into EndNote, 
you cannot import images, graphics, etc.

Before importing, you may need to edit the file to insert 
a comma after corporate author names. Otherwise, 
EndNote will not be able to distinguish corporate authors 
from personal authors.

EndNote Import

CAS SciFinder Save references in the “Tagged Format” (*.txt). SciFinder (CAS) filter

CSA 
(formerly Cambridge 
Scientific Abstracts)

From the CSA search results screen, click Save/Print/
Email. On the “Save/Print/Email” screen, select:

Record Format: Full Record
Save File Format: PC

Click Save. Your Web browser asks where to save the 
file. If your Web browser lets you save in different file 
formats, make sure you save as a “Text Only” (*.txt) file.

Various filters for CSA 
databases are provided 
in the EndNote Filters 
folder.

DIALOG Set your communication software's option to capture 
text. Use Dialog's Format 5 with "tag" appended to the 
TYPE command -- type "s1/5/1-20 tag". 

You must download data in Format 5. If Format 5 is not 
available, try the “full” format, which is sometimes the 
same as Format 5. For questions concerning Dialog’s 
many formats, please contact Dialog's tech support.

Various DIALOG 
filters are provided in 
the EndNote Filters 
folder.

DIMDI Use the DLOAD command with report D1 
(e.g. DLOAD REPORT=D1).

Various DIMDI filters 
are provided in the 
EndNote Filters folder.
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EBSCOhost After adding selected references to your folder, click 
“View Folder” or “Folder has items” to see its contents. 

On the Folder Content page, click Export. On the Export 
Manager page, select “Generic bibliographic 
management software" to save a file to disk. Click Save.

Various EBSCO filters 
are provided in the 
EndNote Filters folder.

EDINA Use the “Name” format, where data is tagged with words 
such as “Author” rather than “AU.”

Because there are so many different formats used for 
source data, you may need to manually edit source data 
after importing.

EndNote cannot parse author names that are not clearly 
delimited, such as 
“S Hughes B Reynolds S A Bell & C Gardner.” You will 
need to manually edit author names.

Various EDINA filters 
are available in the 
EndNote Filters folder.

Emerald Display the marked list, click “display for download 
(ASCII),” and then save as a plain text file.

The filter provided works for these Emerald databases:

Emerald Management Reviews at 
http://www.emeraldinsight.com/revs/

Computer Abstracts International Database at http://
www.emeraldinsight.com/caid

International Civil Engineering Abstracts at 
http://www.emeraldinsight.com/icea/

Computer & Communications Security Abstracts at 
http://www.emeraldinsight.com/ccsa/

Current Awareness Abstracts at 
http://www.emeraldinsight.com/caa/

Limitations:

Page numbers are separated by a hyphen with spaces on 
either side of it. You will need to manually remove the 
spaces after importing. 

Emerald filter

InfoTrac 
(Gale)

From the E-Mail Delivery panel at the bottom of the 
marked list window, restrict the contents to “citation;” do 
not choose “full article.”

Limitations:

Records often have extraneous information in the title 
field, which must be removed manually after importing.

InfoTrac (GALE) filter

Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option
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INIST 1.  Click the Enregistrer button.

2.  Select the records you wish to download. 

3.  Under “Quels champs?” choose "Tous les champs."

4.  Under “Incluez” choose "Numéro de notice et nom de 
la base de données" and "Libellés abrégés."

5.  Click the Sauvegarde de notices button.

Various INIST filters 
are provided in the 
EndNote Filters folder.

INNOPAC Save references in the “EndNote” format. EndNote Import

Knowledge Finder Place document in the Save file, and select the document. 
Choose Export Selected Documents from the File menu.

Various Knowledge 
Finder filters are 
provided in the 
EndNote Filters folder.

Medscape After selecting the desired records and adding them to 
your clipboard, click the Save or Email Clipboard link. 
Save or email your clipboard in PC or Mac MEDLARS 
format as a plain text (*.txt) file.

MEDLINE (Medscape) 
filter

NERAC Save your file as plain text (*.txt). NERAC

OCLC FirstSearch 1. Mark the records you wish to download.

2. In the navigation pane, click Export.

3. Click the radio button next to “The marked records” or 
“A range of records.”

4. Click the radio button next to “EndNote.”

5. Click Export and save to a Text file.

Various OCLC filters 
are provided in the 
EndNote Filters folder.

Ovid 1. After selecting the references you wish to download, 
click Results Manager. 

2. Choose the following options:

Fields:  Complete Reference

Citation Format:  Reprint/Medlars (or     Direct 
Export, if available)

3. Click the Email or Save button. 

4. Save the file as plain text (*.txt).

The appropriate Ovid 
filter will be selected 
automatically when 
using the Direct Export 
option. If you are using 
Ovid's multiple 
database searching, you 
must select the Direct 
Export citation format.

Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option
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ProQuest 1. Select the desired references and then click the “My 
Research Summary” tab.

2. Click the “Documents and Bibliography” tab.

3. Choose “Export,” then either “Export directly to 
ProCite, EndNote or Reference Manager,” or “Download 
in a format compatible with ProCite, EndNote, Reference 
Manager and RefWorks.” If you choose the former, make 
sure your data is displayed in a tagged format before 
saving as a text file.

ProQuest filter

PsycINFO 
http://www.apa.org/
psycinfo

After marking the records you wish to download, choose 
Full PsycINFO Record then click the Display Marked 
Records button. Select the text, then copy and paste it 
into a text editor, saving the file as plain text (*.txt).

Use the PsycINFO 
(APA) filter.

PubMed 1. From the drop-down menu next to the Display button, 
choose MEDLINE.

2.  From the “Send to” menu, choose File and save the 
file as a plain text file (*.txt).

Note that the PMID will transfer to the Accession 
Number field in EndNote.

PubMed (NLM) filter 

SilverPlatter WebSPIRS 1. Once you've obtained your search results, click Save. 

2.  Select the following “Save Records” options:

Which fields?: All fields

Include: Record number and database name

Field labels: Short labels.

3. Click the Save Records button. 

4. Use your Web browser to save the page as "Text Only" 
(do not save in HTML format).

Various SilverPlatter 
filters are provided in 
the EndNote Filters 
folder.

STN Set your communication software’s options to capture 
text to a file. Type the command “Display All”.

Various STN filters are 
provided in the 
EndNote Filters folder.

UnCover (Ingenta) Using your email software, save references emailed to 
you as a "Plain Text" or "Text Only" file.

UnCover (INGENTA)

VHL
(Virtual Health Library)

1. After selecting the desired references, scroll to the 
bottom of the page and click “Your collection” (or “Su 
selleccíon”).

2. Cancel the print dialog, and then save the screen as a 
plain text file.

Various VHL filters are 
provided in the 
EndNote Filters folder.

Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option
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Direct Export 
from Web 
Pages

Certain websites contain a download button that will send your 
search results directly to EndNote, pick the correct import filter, 
and start the import process automatically. Start by opening the 
EndNote library into which the data should be imported. This 
“direct export” or “direct download” method does away with 
the additional steps of saving the references to a text file, and 
then importing that file with the appropriate filter. 

The systems listed below provide a direct export of references 
into EndNote. A detailed table of instructions can be found in 
Appendix D of the full EndNote manual. The list keeps growing, 
so contact your information provider to find out whether they 
participate!

Web of Knowledge
Web of Science

Display your marked references. Then, look under 
Output Records and select the option to output Full 
Records. Next, click Export to Reference Software to 
have the references exported directly to EndNote. You 
may also choose Save to File to save the references to a 
text file and import them into EndNote.

ISI-CE filter

Wilson 1. Click Print Email Save. 

2. Click Export to Bibliographic Software. 

3. Choose The EndNote Filter and click Export.

4. Save to a text file.

WilsonWeb filter

WorldCat 
(OCLC FirstSearch)

1. Mark those references to be saved and click Export.

2. Choose Text File. 

3. Click Export.

WorldCat (OCLC) filter

Output Formats and Corresponding Import Options

Information Provider Recommended Download Format Import Option

ALEPH Los Alamos National Laboratory
American Psychological 
Association, PsycInfo Online

MicroPatent

Bibliotech.dk Nature
BioMedCentral Nerac
BioOne NISC
Blackwell Synergy OCLC
BMJ OhioLink
Buffalo University OVID
Chapter 6: Importing Reference Data into EndNote 67



This concludes the tutorial for using EndNote’s Import 
command. 

If you are finished working with EndNote for now, go to the File 
menu and choose Exit to close the EndNote program.

Related 
Sections in the 
Full Manual

See these sections in the full EndNote.PDF manual for 
information related to this portion of the tour:

See Chapter 7, “Importing Reference Data into EndNote,” for 
details about import options and about importing references 
from other bibliographic software programs.

Read Chapter 17, “Filters,” to learn how to create or modify 
filters that map downloaded references to corresponding 
fields in EndNote. You can enter tags and map them to 
specific EndNote fields.

See Appendix D, “Direct Export Formats and Import 
Formats” for detailed tables of instruction for importing 
reference data from various online systems.

CABI-Direct Oxford Press Journals
Canadian Journal of 
Communication

Pacific Northwest Labs

CCLR Patent Cafe
Delphion PILOTS
EBSCO PNAS Online
EI Engineering ProQuest
Elsevier RLG
EMBASE Science Magazine
ERIC Scopus
ESDS Government St. John of God, Ireland
Google Scholar Stanford University's Highwire Press
HAPI Telemed
IEEE Thieme
JAMA Web of Science
JISC WebFeat
JSTOR WilsonWeb
Karger Publishing
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